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Using This Guide

This user guide provides instructions for installing, operating and maintaining 
Stratasys J4100 3D printing systems. It explains how to use features, and 
provides practical examples to guide you as you use the system.

Important: Read the entire Safety chapter before using the system. 

The text and figures in this guide are based on the J4100 3D printer, software 
version 41.01 (DT 11).

This guide assumes that—

• all the hardware, software, and network components of your  system are 
installed, configured, and operating correctly.

• the operator has a working knowledge of the Windows® PC platform.

For More Information

Visit the Stratasys Support Center to download the latest revision of this 
document.This document is also available on the Support Center in other 
languages.

If you have any questions or comments about the way information is presented in 
this guide, or if you have any suggestions for future editions, please send a 
message to c-support@stratasys.com.

 

Revision History

The following table lists the main changes in each revision of this document.

Revision Release Date Description
Rev. C February 2021 • About this Guide was updated.

• Additional Resources was added.
• Workstation Requirements was updated.
• Replacing the Odor Filter was updated.
• Replacing the UV Lamps was updated with 

instructions for replacing the UV lamp bulb.
• Photobleaching for Transparent Models was 

updated.
• Text, style and format improvements.

https://support.stratasys.com/
mailto:c-support@stratasys.com
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Terms Used in This Guide

Build tray In the print preparation application: The surface displayed on the 
screen that represents the actual build tray in the printer.
In the printer: The surface upon which models are produced.

Cleaning fluid Cleanser for flushing material feed tubes and the printing block, used to 
completely remove Model and Support material from the system before 
loading another type of material in the printer and before long-term 
shutdown. The cleaning fluid is supplied in material containers.

Client/user 
workstation

The workstation on which  software is installed for preparing build trays 
for production on PolyJet printers. (There is no limit to the number of 
client workstations.)

GrabCAD Print A software application for preparing print jobs on a variety of 3D 
printers, including J4100 printers.

Mixed part Models whose parts are printed using more than one model material.

Mixed tray A build tray containing objects, each of which is designed to be printed 
using a different model material.

Model material Material used for building models.

Printer 
computer

The computer inside the J4100 printer that operates it.

Printer 
interface

The GUI (graphical user interface) used for controlling J4100 printers.

Printer 
software, 
printer-control 
application

Software running on the computer in the J4100 printer, controling all 
printer operations.

Resin The base substance from which photopolymer printing materials are 
made for use in Stratasys PolyJet printers.

STL A file used for printing 3D models.

Support 
material

Material used for supporting the structure of models during production.
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Additional Resources

Stratasys encourages you to learn more about your additive manufacturing 
printer, its capabilities and the technology. A wealth of information is available on 
our online digital platforms.

Stratasys Academy

Stratasys Academy is your online learning platform. Here you can browse our 
extensive and growing course catalog, register to webinars, view  tutorials and 
videos at your own pace, and enroll in face-to-face, in person courses. We 
encourage you register and start your leaning journey today.

 

https://stratasys.plateau.com/learning/user/portal.do?siteID=CUSTOMERS&landingPage=login
https://support.stratasys.com/Academy Registration
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Stratasys Support Center

The Support Center is your portal to thousands of knowledge assets, including 
information on design, applications, and materials. The site also has links to 
Web-based training, "how-to" videos and the Stratasys blog. In addition, you can 
check the latest revision of the user guide for your printer, and download 
documents in different languages.

The Support Center is available in multiple languages. You can change the 
display language using the language drop-down menu in the top-left corner of 
the homepage. 

 

GrabCAD Community

The Tutorials section of GrabCAD Community portal is a valuable source for 
Stratasys-sponsored and user-genertated 3D printing tips. You can also ask 3D-
related questions on the portal and download free CAD files.

http://support.stratasys.com/
https://grabcad.com/tutorials
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Safety Features

J4100 3D printers are equipped with the following safety features:
Interlock Switch

The power supplied to the UV lamp and the motion motors is 
turned off when the doors are opened. 

Warning
Do not defeat (override) the interlock switch. Doing so could 
result in serious personal injury. If the interlock switch does not 
function correctly, do not use the printer, and contact your service 
provider.

Safety Lock
The doors are locked while the printer is working. The lock is 
released when the printer reverts to pause or stop mode.

Warning
Do not defeat (override) the safety lock. Doing so could result 
in serious personal injury. If the safety lock does not function 
correctly, do not use the printer, and contact your service provider.

UV Screening
The transparent section of the doors blocks harmful UV radiation, 
allowing the operator to view the model as it is being made.

Circuit Breaker
The power to the printer is turned off in case of electrical 
overcurrent. 
Note: The circuit breaker is only accessible to service personnel.

UV-Lamp Overheating 
Protection

The power supplied to the UV lamp and the motion motors is 
turned off if the temperature around the lamp reaches 90°C 
(194°F). A label on the UV-lamp cover indicates if the temperature 
has exceeded 65°C (150°F).

 

Grounded Chassis
The chassis of the printer is grounded, to prevent electrical shock.
Note: The power outlet must be grounded in accordance with the 
local electric code to provide this protection.
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Emergency Stop
Emergency stop switches are located on the front and back of the 
printer.

Important:  Pushing the emergency stop switch disconnects 
power to the motors only. This switch does not disconnect the 
power supply to the printer; printer circuits remain live.

Figure 2-1 J4100—front view

Figure 2-2 J4100—rear view

If the printer is not used as specified in this guide, these safety features may not provide 
adequate protection.
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Symbols and Warning Labels

The following table lists the warning labels located on or in the printer.

Warning Symbol Meaning Location Comments
Hazard (general) On the name plate on the 

back of the printer.
Read the instructions in 
this document before 
operating the printer.

Hot surface On the print block. Risk of burns. Do not 
touch this surface after 
printing.

High voltage Near the UV lamp 
connectors.

Near the power-supply 
enclosures.

Risk of electric shock. 
Disconnect the power 
before servicing.

Ultraviolet radiation

 

 Risk of injury to skin and 
eyes from ultraviolet 
radiation. Disconnect the 
power before servicing.

 

Moving parts

 

 

At the sides of the build 
tray, visible when the 
doors of the printer are 
open.

Risk of injury from moving 
parts. Keep body parts 
away from moving  parts.
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Safety Guidelines

The following general guidelines, together with the instructions provided 
throughout this user guide, ensure user safety while operating and maintaining 
the system. If the system is not operated as specified, the user's safety 
may be compromised.

Printer Installation

➢  Installation and removal of the printer should only be done by qualified service 
personnel. 

➢  Connect the printer and the UPS unit to the electric outlet using a power cable 
that is safety-certified.

➢  Never connect the power plug to an outlet that does not have a ground (earth) 
wire, and never disconnect the ground. Doing so might expose the operator 
to serious danger from electric shock.

➢  The following safety statement is followed by translations to Finish, 
Norwegian, Swedish and Danish, as required by local regulations: 
“The machine must be connected to a grounded power outlet.” 

❒  FI: Laite on liitettävä suojakoskettimilla varustettuun pistorasiaan.
❒  NO: Apparatet må tilkoples jordet stikkontakt.
❒  SE: Apparaten skall anslutas till jordat uttag.
❒  DK: Apparatets stikprop skal tilsluttes en stikkontakt med jord, som giver 

forbindelse til stikproppens jord.

➢  Leave a minimum of 100 centimeters (40 inches) between ventilation 
openings and walls or other objects.

➢  For Japan: The power cable supplied is provided for connecting the printer 
to the AC electric source. Do not use it with other equipment.

Printer Operation

➢  The printer should only be operated by persons trained by an authorized 
Stratasys representative.

➢  All persons operating or maintaining the printer should know the location of 
first aid and emergency equipment and how to use it. Never block access 
to this equipment.

➢  Keep fingers and other body parts clear of the printer when closing the cover.

➢  Never attempt to open the front doors of the printer while it is working.

➢  Never override the interlock safety switch.

➢  If the interlock safety switch ever fails, do not use the printer. 
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➢  Never attempt to open the service window on the right side of the printer. This 
window should always remain locked, except when the printer is serviced by 
authorized personnel. Do not operate the printer if it is open.

Figure 2-3    Service window on right side of printer

➢  Several parts of the printer remain extremely hot even after it has stopped 
operating. Avoid touching the UV lamps and the print block. 

UV Radiation

The UV lamps used in the printer emit dangerous radiation

➢  If the UV lamps remain on when the printer is open, do not stare directly at the 
UV light. Shut down the printer and call your Stratasys service provider.

Printer Maintenance

➢  Service operations should be performed only by qualified personnel who 
have been instructed in relevant safety precautions.

➢  Notify co-workers and those who have access to the printer before beginning 
non-routine and hazardous work.

Report any potential dangers and safety-related accidents to your safety 
officer or to other appropriate authorities.

Model and Support Materials

Model and Support materials are made of chemical substances. Although 
precautions must be taken when handling these materials directly, all Model and 
Support materials used by the printer are handled in sealed containers. 
Normally, operators of the printer should never be directly exposed to hazardous 
materials. In the unlikely event of a leak or spill, follow the instructions that are 
included with the material containers used.

➢  Store Model and Support materials indoors, in a dry area with adequate 
ventilation, between 15-25 degrees Celsius (59-77 degrees Fahrenheit). 
Never expose them to flames, heat, sparks, or direct sunlight.

➢  Keep Model and Support materials away from areas where food and drink 
are stored, prepared and consumed.
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➢  Uncured printing material is considered a hazardous substance, requiring 
certain precautions when directly handling it. To prevent skin irritation, wear 
neoprene or nitrile gloves. If there is any chance that Model and Support 
materials might splash into the eyes, wear safety goggles. Prolonged direct 
contact with printing materials can cause an allergic reaction.

➢  When handling UV-cured models that may not be completely cured on the 
surface, common latex gloves are adequate. 

➢  To prevent respiratory irritation, ventilate areas where Model and Support 
materials are used.

➢  Clean up Model-material and Support-material spills with disposable towels 
or other absorbent, non-reusable material, such as sawdust or activated 
charcoal. Rinse the spill area with denatured or isopropyl alcohol (IPA), 
followed by soap and water. Dispose of the absorbent material in accordance 
with local regulations.

➢  Do not wash contaminated clothing at home; clothing should be 
professionally laundered.

➢  Dispose of contaminated shoes, belts and other leather items in accordance 
with any applicable regulations. Absorbed printing material may re-expose 
the user when these items are worn.

UV Lamps

UV lamps used by the printer to cure printing materials contain a small amount of 
mercury. In the unlikely event of lamp breakage, avoid inhaling mercury vapor, 
and ventilate the room. If the lamp ruptures (breaks) during operation, leave the 
room and ventilate it thoroughly for about 30 minutes. 

Use protective gloves to prevent contact with mercury and other lamp 
components. Carefully remove spilled mercury with a method that prevents the 
generation of mercury vapor, such as a syringe, packing tape or paper. 

Place the broken lamp, mercury and contaminated materials in an air-tight, non-
metallic container. Dispose of the container in accordance with applicable 
regulations.
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First Aid for Working with Printing Materials

In general, try to avoid direct contact with uncured printing material. If skin or 
eyes come into contact with it, wash the area immediately and thoroughly with 
water, and follow these first-aid instructions.

The Material Safety Data Sheet (MSDS) that accompanies printing materials 
contains important safety information. Keep this in an accessible place where 
these materials are used and stored.

Contact with Skin

If uncured printing material comes in contact with skin, wash the affected area 
immediately and thoroughly with soap and cool water, then remove 
contaminated clothing. Pay particular attention to flushing the hair, ears, nose 
and other parts of the body that are not easily cleaned. 

➢  Use cool water to prevent skin pores from opening, so that the liquid material 
does not easily penetrate the skin. 

➢  Do not use solvents to clean skin. 

➢  If large areas of skin have been exposed, or if prolonged contact results in 
blisters, seek medical attention. In any case, if irritation persists, seek medical 
attention. 

➢  Avoid the accidental transfer of printing material from the hands to other 
areas of the body, especially to the eyes. 

➢  If protective cream was used, do not reapply it until the skin has been 
completely cleansed. 

Contact with Eyes 

If uncured printing material comes in contact with the eyes, flush immediately 
with large amounts of water for 15 minutes and seek medical attention. 

➢  Avoid sunlight, fluorescent light, and other sources of ultraviolet radiation. 
Wearing contact lenses when handling liquid printing materials is not 
recommended. If the liquid splashes into the eyes when contact lenses are worn, 
immediately remove the lenses and flush the eyes with water. 

➢  Clean and disinfect the contaminated lenses. 

➢  Do not wear contact lenses until eye irritation disappears.

Ingestion

If printing material is swallowed, refer to the instructions included with the 
cartridge. Seek medical attention immediately.
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Inhalation

Vapors from printing materials can be irritating to the respiratory system. If 
respiratory irritation occurs, expose the victim to fresh air immediately.

➢  If the victim has stopped breathing, perform artificial respiration or 
cardiopulmonary resuscitation. 

➢  Seek medical attention immediately.

➢  Keep the victim warm but not hot. 

➢  Never feed anything to an unconscious person.

➢  Oxygen should be administered by authorized personnel only.

Waste Disposal 

Fully cured printed models can be disposed of as ordinary office trash. However, 
special care is required when handling printer waste (uncured printing material).

Printing Materials

➢  When removing the waste container from the printer, wear neoprene or nitrile 
gloves.

➢  To prevent liquid waste from splashing into the eyes, wear safety goggles.

➢  Liquid waste from the printer is classified as hazardous industrial waste. 
Therefore, printing-material waste must be packaged and disposed of in a 
manner that prevents human contact with it and contamination of water 
sources.

➢  Empty Model-material and Support-material containers contain residue of 
their contents. Some leakage of this residue may occur through the broken 
container seal. Therefore, handle and store empty containers with care. 

➢  Do not attempt to reuse empty containers, and do not puncture them.

➢  Dispose of used containers and waste containers in accordance with local 
regulations.

➢  Discard contaminated clothing, shoes, empty containers, etc., in accordance 
with any applicable regulations.

UV Lamps

UV lamps used by the printer to cure printing materials contain a small amount of 
mercury, and are considered “Universal Waste.” Recycle or discard used lamps 
in accordance with applicable regulations.

Broken lamps: 
After ventilating the area, use protective gloves and carefully remove spilled 
mercury with a method that prevents the generation of mercury vapor, such as a 
syringe, packing tape or paper. Place the broken lamp, mercury and 
contaminated materials in an air-tight, non-metallic container. Dispose of the 
container in accordance with applicable regulations.
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Work Configurations

Stratasys J4100 3D printing systems can be set up as single-station systems or 
as multi-station systems. When connected to a local computer network, the 
system can serve multiple users. In such configurations, each user (client) 
prepares files  for production. A server in the printer processes jobs and controls 
the printing.

Figure 3-1 shows the printer set up in a multi-client configuration.

Figure 3-1    Multi-client network configuration
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Source Files

Stratasys J4100 printing systems produce three-dimensional models designed 
with most CAD tools and some other 3D applications. 

GrabCAD Print supports STL, VRML, OBJ and 3MF files. In addition, GrabCAD 
Print supports native CAD formats from these programs: Creo, SOLIDWORKS, 
NX, CATIA and Inventor. To see the complete list of file formats supported by 
GrabCAD Print, go to: help.grabcad.com/print/file-formats.

J4100 systems feature the capability of producing different types of model files 
simultaneously.

 

http://help.grabcad.com/print/file-formats
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Printing Materials

Stratasys J4100 printers produce models by jetting thin layers of printing 
materials on the build tray, until the complete model is formed. Two types of 
material are used in this process:

• Model material—which makes up the finished model

• Support material—which fills gaps and spaces in the model during printing, 
and is removed after printing

For up-to-date information about PolyJet printing materials and their 
properties, go to www.stratasys.com/materials/polyjet.

Storage

Materials used for printing models with J4100 printers are made of resins, which 
are composed of reactive monomers and oligomers. Although printing materials 
are supplied in sealed, UV-proof containers, care must be taken when storing 
and handling them. Follow these guidelines to protect operators and the 
environment, and to ensure optimum results. 

• To ensure product stability, do not allow these materials to come into contact 
with metal. Plastics made from monomer-soluble substances (such as 
polystyrene or polyvinyl chloride) are not suitable for storing PolyJet printing 
materials.

• When not in use, keep material containers tightly sealed to prevent 
contamination, the effects of exposure to UV radiation, and accidental 
spillage.

• Store material containers indoors, in a dry area with adequate ventilation, 
between 15–25 degrees Celsius (59-77 degrees Fahrenheit). If exposed to 
heat or flames, containers might burst or ignite.

• Signs of premature polymerization in material containers include bulging, 
leaking, the emission of heat, and unusual odor. Exposure to heat can cause 
resin to gel in the containers.

• Make sure that material containers are stored in accordance with all local 
regulations and other applicable requirements.

Shelf Life

Materials used for producing models have a limited shelf life. The expiry date on 
the label is valid when properly stored in an undamaged, unopened container. 
Always rotate your stock, so that the container with the earliest date is used first.

Exposure to Light

If printing materials are not in their sealed containers, make sure to shield them 
from sunlight and other sources of UV radiation, such as fluorescent and 

http://www.stratasys.com/materials/polyjet
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mercury-vapor lights. Exposure to UV radiation causes an increase in viscosity 
and, eventually, solidification.

Safety Considerations

Before being cured, resins are hazardous materials. To prevent possible health 
hazards, follow these precautions regarding printing materials: 

• Do not expose to flames, heat or sparks.
• Prevent contact with skin and eyes.
• Ventilate areas where they are handled. 

• Keep them separate from food and drink.
Cured plastic parts, however, are safe. They can be handled and stored without 
precautions.

You can find more safety information about resins in:
 l "Safety Guidelines" on page 2-5
 l "First Aid for Working with Printing Materials" on page 2-8

Disposal

Dispose of containers of model and support material in accordance with all 
applicable laws and regulations. 

Work Environment

Extreme heat and humidity conditions can adversely affect the operation of your 
J4100 3D printer. Use ventilation or air-conditioning systems, if necessary, to 
keep the work area within the following ranges:

• 18°–25° C (64°–77° F)
• 30%–70% relative humidity
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Figure 4-1    The Stratasys J4100 3D Printer

Starting the  Printer

Caution
 l Do not attempt to operate the printer before being trained by an authorized 

Stratasys representative.
 l Observe all safety warnings and follow the safety guidelines described in 

Chapter 2.

1. Turn on the main power switch, located at the back of the printer.

 
Figure 4-2    Main power switch
The main power switch turns on the J4100 printer, which includes the built-in 
computer. 
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2. After the printer-control computer boots, log in to Windows and launch the 
printer-control program:
❒  On the printer-computer desktop, double-click the J4100 printer icon.
or—

❒  From the Windows Start menu, select (All) Programs > Objet > J4100.

A HASP plug containing a valid product activation key is required on the 
printer computer. This is supplied during printer installation or upgrade. If the 
application does not open and a HASP message appears, contact your 
Stratasys dealer or service provider.

The printer-control computer displays the main printer interface. All monitoring 
and controlling of the printer is done from this interface.

Figure 4-3    Printer interface
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Loading Model and Support Containers

The number of material containers loaded in J4100 printers depends on the 
active printing mode. 

• In High Speed mode, you can print with up to three different Model materials. 
Each material channel (M1, M2, M3) can be loaded with two containers of the 
same material. One or two containers of Support material are loaded in the S 
channel.

• In Super High Speed mode, you print with one type of Model material, in the 
M1 and M2 channels (2–4 containers). Up to four containers of Support 
material are loaded in channels S and M3.

A graphical representation of the containers loaded and their current weight 
appears in the printer interface (see the figure on the previous page).

The material containers are located in storage compartments on both sides of the 
printer. The position of the containers shown in the interface screen corresponds 
to their location in the printer. The waste containers are placed outside of the 
printer, typically in the back.

The printer uses RFID technology to automatically identify containers of 
printing material. Tampering with the RFID module  will render the printer 
inoperable and may void Stratasys warranties and service contracts.                 

Important: If you need to replace the printing material currently installed with 
another type, see "Changing the Printing Material" on page 4-15. Otherwise, 
make sure to replace the material cartridge with one containing the same type of 
material.

To load Model and Support material:

1. On the side of the printer, pull open the doors of the storage compartment.

2. If you are replacing a material container, disconnect it from the feed tube. 
Then, grasp the handle and pull the container out of the printer.

3. Load Model and Support containers into their respective compartments.
Lift full material containers  carefully, using both hands. It is recommended 
that you use a lifting handle similar to the one shown here.

Figure 4-4    Material container lifting handle
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4. Attach the material feed tube to the container.

When preparing a new feed tube, make sure that the air hole in the cap is 
open.

Figure 4-5    Material container cap
You should hear a clicking sound when the connector is securely attached to 
the container. Make sure that the connector is secure.

5. Check the printer interface to make sure that the new container is detected 
and that its weight is displayed (see the figure on page 4-4).

6. Close the storage-compartment door.

Tips about loading and replacing material containers:
 l You can replace material containers either before or during printing. 
 l You can load partially used containers, provided that they contain more than 

100 grams of material.
 l You can replace a partially used container to avoid the need for replacing it 

during printing. 
 l The container type is automatically detected by the printer. If you replace a 

container with one that has different Model material, a message appears 
recommending that you run the Material Replacement wizard to flush out the 
old material.

 l If printing stops for an extended time before you replace a material container, 
the printer may go into Standby or Idle mode. If this happens, see "Resuming 
Production After Printing has Stopped" on page 4-11.
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Producing Models

Models can be printed after they are arranged on a virtual build tray in the 
GrabCAD Print application. For information about preparing model files for 
printing, see the GrabCAD Print online documentation.

Preparing the Printer

Before beginning to produce models, it is recommended that you check the 
current printing quality of the print heads by performing the Pattern Test.

To prepare the printer for producing models:

1. Make sure that the build tray in the printer is empty and clean. If not, remove 
cured material with the scraper, and clean the tray thoroughly with a cleaning 
cloth soaked with 90% alcohol (IPA or ethanol).
The build tray for the J4100 printer is removable, which aids in the removal 
and handling of printed models. Make sure that the build tray is installed when 
preparing the printer for producing models. 

Caution
Use protective gloves when cleaning the build tray, and be careful of the 
sharp edges of the scraper blade.

2. Check that the print heads and roller assembly are clean. If not, clean them 
before printing, especially if the print job is longer than 100 hours. 

3. Make sure that there is sufficient Model and Support material loaded, as 
indicated on the printer interface (see the figure on page 4-4). You may want 
to replace the containers of Model and Support material currently loaded in 
the printer to avoid the need for replacing them during printing.

Note: When you click Print in GrabCAD Print, a warning message appears if 
there is not enough of one or more material.

For installing material containers  and replacing empty ones, see "Loading 
Model and Support Containers" on page 4-5.

For changing the type of material currently loaded, see "Changing the Printing 
Material" on page 4-15.

http://help.grabcad.com/collection/189-print
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You can monitor printer status by switching the printer interface display. To do 
this, click the display toggle button on the printer interface screen.

Figure 4-6    Printer status

Starting Printing

To begin printing:
➢  On the printer interface, click the red button to switch the printer to online 

mode.
The color of the button changes from red to green (see the figure on page 4-
4). If there is a job in the Job Manager queue, it is sent to the printer. If there is 
a job in the printing queue, it is sent to the printer.

When switching the printer to online mode, a message is displayed if a 
maintenance activity is required to ensure optimum printing quality. (See 
"Routine Maintenance Schedule" on page 4-30.) Maintenance notifications 
can be disabled/enabled from the Options menu.

Before printing a job, the software executes a set of hardware and software tests 
to ensure optimum printing results. In the printer interface, the printer mode 
changes from Idle to Pre-print, as the printer’s components prepare themselves 
for production: 

• The print block is heated.

• The UV lamps are powered and they warm up.
When printing begins, the print manager program sends a number of slices to the 
printer-control application. This fills the  buffer between the print manager  and the 
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printer to ensure continuous printing. As each slice is printed, as a layer of the 
models on the build tray, another slice is sent to the printer.

Depending on the size of the model(s) to be produced, printing can take between 
several hours to several days. As long as there is enough Model and Support 
material in the supply containers, printing proceeds automatically until the job is 
finished.

The  printer uses one or two material containers in each channel to produce 
models. If additional containers are installed and they are not immediately 
needed for printing, the printer interface indicates this (see "Printer Interface 
Color Key" below).

Printer Interface Color Key

The background colors in the printer indicator fields tell you at a glance whether 
or not the value or item is suitable or ready for printing. 

• Green—suitable/ready for printing
For example, in Figure 4-6 on the previous page:

❒  Heads (°C)—The heads have reached the temperature required for 
printing models.

❒  Ambient—The ambient temperature of the printing chamber is within the 
acceptable range.

❒  Heads Liquid—The level of Model and Support material in the print-block 
reservoir is OK.

❒  Heads Vacuum—The vacuum level in the system is within the acceptable 
range.

❒  Exhaust Flow—The flow of exhaust air from the printer is OK.
❒  Pre-Heaters—The Model and Support resins have been heated to the 

required temperature before being supplied to the print block.

 
• Blue—not ready

For example, in Figure 4-6 on the previous page:

❒  UV lamps—The UV lamps are not on.
 

• Red—not suitable for printing (or indicates a warning)
For example, in Figure 4-3 on page 4-4:

❒  Waste—The weight of the waste container is over 17,500 grams.
The color of the material containers displayed in the printer interface indicates 
which containers are active for the current (or next) print job.

For example, in Figure 4-3 on page 4-4:

• Blue—active container

• Gray—reserve container
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Printing Indicators

The printer interface screen changes when you send a print job to the printer, if 
the printer is online:

• The mode changes from Pre-print to Printing. 
• The specific activity being performed is shown in the “current activity” field. 

• Current job-printing information is displayed.

• The printing progress bar is displayed.

• The Stop and Pause buttons are enabled.
When the weight of a container drops below 100 grams, the display of the 
material level in the printer interface is red. 

Figure 4-7                Printer interface during printing
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Resuming Production After Printing has Stopped

If the printing process is interrupted, the print manager stops sending slices to the 
printer. This can happen, for example, if the printing material runs out in the 
middle of a print job, and you do not replace the empty container immediately.  
After the printer changes to Standby or Idle mode, you need to resume printing 
from the print manager in GrabCAD Print.

After printing stops, the printer goes into Standby mode, when heating of the 
print heads is reduced. About 10 hours later, the printer goes into Idle mode, 
when heating of the print heads is stopped. 

To continue printing the model:

1. If the printer is in offline mode, switch it to online mode by clicking the red 
button at the bottom of the  printer interface.

The button changes from red to green.

2. If you don’t know why printing has stopped, make sure that the connection 
between the printer and the server computer is active.

3. Open the Schedule screen of GrabCAD Print.
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Figure 4-8    Opening the Schedule screen 

4. Locate the stopped job.

Figure 4-9    Stopped job in the Schedule screen

5. Click on the job to display the Job Status details, and click the Resume  icon 

. 
OR—

Right-click on the job to display the pop-up menu, and select Resume job.

6. In GrabCAD Print, make sure that the correct slice number is entered in the  
dialog box.

Figure 4-10    Slice confirmation in GrabCAD Print
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Figure 4-11    Printer interface after interrupted printing

7. If, for any reason, the correct number does not appear in the dialog box, enter 
the number and click OK.

You cannot continue printing the model if:

• The number of the last slice printed does not appear in the printer interface, 
even if the server computer displays the confirmation dialog box.

• There was a relatively long interruption in printing, even if the “last slice” and  
indicators are correct. This is because the part already printed might slightly 
deform or shrink before printing continues, causing a visible difference 
between it and the part of the model printed later. The effects of a printing 
stoppage depend on the model size and structure, the Model material used, 
ambient temperature and the length of the stoppage.
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If you cannot continue printing: 

1. Cancel the job.
In GrabCAD Print, in the Schedule screen (see above): 

❒  Right-click on the job to display the pop-up menu, and select Cancel job.

OR—

❒  Left-click on the job to display the Job Status details, and click the Cancel  

icon . 

2. Remove the partially printed model from the build tray. 

3. Resend the job to the printer.

❒  Click .

You can stop  printing from either the printer interface or from GrabCAD Print. 

• After clicking the Stop button in GrabCAD Print, you can resume   printing 
from GrabCAD Print or from the printer interface.

• After stopping printing from the printer interface, you can resume printing 
only from the printer interface. 

• After clicking the Pause button in the printer interface, you can resume 
printing only from the printer interface.
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Changing the Printing Material

Before producing models using a different type of printing material than is 
currently installed, run the Material Replacement wizard to flush the print block 
and feed tubes.

After changing Support material with the wizard, Head Optimization is 
required before printing models.

You should carefully plan printing models with different materials to avoid 
unnecessary waste of the materials currently loaded. 

Note: When performing manual material replacement, certain  replacement 
options are blocked to protect the system. In these cases, follow the 
recommendations of the Material Replacement wizard for best replacement 
options.

To replace the printing material with the wizard:

1. Start the Material Replacement wizard from the Options menu.

Figure 4-12    Starting the Material Replacement wizard

2. In the opening screen, click Next.

3. If the printer doors are not closed, a screen appears, prompting you to close 
them. Confirm this and click Next.
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4. Choose the configuration for producing models:
❒  3 Materials (High Speed)
❒  Single Material (Super High Speed)

Figure 4-13    Material Replacement Options
3 Materials
Both sections of each print head are loaded with  the same material.

 
Figure 4-14    Three materials loaded in the print heads
Up to three Model materials are available, with high-speed printing.
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Single Material
Both sections of two print heads are loaded with  the same Model material.
Both sections of two print heads are loaded with Support material.

 
Figure 4-15    One Model material loaded in the print heads
This mode produces parts in Super High Speed mode, at a layer resolution of 
55 microns.

5. In the Required materials section of the wizard screen, select one or more 
replacement materials containers.

6. For Model materials, select Both if you need to load two replacement 
containers.
Loading one replacement container is more economical because it potentially 
requires less flushing of material currently in the system. However, when one 
container is not sufficient, loading two containers enables continuous printing 
until the print job is completed. When one container empties and the other 
one is being used, you can replace the empty container with a new one.

7. For Support material, select Both if you need to load two replacement 
containers.
❒  In High Speed mode, you can print using one or two Support cartridges.
❒  In Super High Speed mode, at least two Support cartridges are required; 

you can print with up to four Support cartridges.

8. If the color or mechanical properties of the first printed models are 
unimportant, and if you did not change the printing mode, you can replace the 
Model materials without flushing out the current materials. To do so, continue 
with  "Changing Model Materials Without Flushing" on page 4-20.
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9. To flush out material currently in the system, choose the flushing cycle that fits 
your needs:

The default flushing cycle is the one used for the last material replacement.

❒  Economy. This cycle can be used when replacing a light-colored Model 
material with a darker material (such as Agilus30 Black™ or 
VeroBlack™) or if the exact color of the printed models is unimportant. 
Use this cycle when replacing cleaning fluid with any Model material.

The wizard flushes the system with the minimum amount of material 
needed to ensure that models have the mechanical properties of the new 
material.

❒  Full. Use this cycle when the printed models must have the exact color of 
the new material.

The wizard thoroughly flushes  the feed tubes and print heads needed for 
printing, based on your selections in the previous screens. 

There are additional settings that you can select for special purposes (see 
"Advanced Settings"). If necessary, click Advanced Settings before clicking 
Next.
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10. Click Next to begin the material replacement process in the printer.
The positioning screen appears, showing you the new location of the 
containers in the materials compartments.

Figure 4-16    Container placement
Symbols:

 The correct container is in this position.

 No container (or the incorrect container) is in this position.

 The container in this position has insufficient weight to complete the material 
replacement process.

 The expiration date of the container  in this position has passed.

11. Replace material containers as necessary, according to the instructions in the 
wizard screen.

Make sure to securely attach the cap to partially used material containers 
when not loaded in the printer. If not properly capped, exposure to UV light 
could cause polymerization (curing) of the material, making it unsuitable for 
printing.

12. Click Start.

13. Read the warning message, and click OK.

If you continue, you must complete the material replacement process before 
you can produce models. To replace material containers at another time, click 
Cancel. If you continue (by clicking OK) and you do not complete the process, 
you will need to run the wizard again before producing models. 
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14. In the final wizard screen, click Done.
The printer-control application is automatically updated, and it restarts. 

When it opens, the interface displays the new material(s). 

 The interface in the job preparation application  is also updated, and it 
displays the new material(s).

15. Inspect the area around the purge unit and clean it, if necessary.

Empty material containers can be used as printer-waste containers.

Before printing models, you need to run the Head Optimization wizard in 
these cases:
 • after changing the printing mode
• after replacing Vero with Digital ABS or Agilus30 Model materials (and the 
reverse)
 • after replacing the Support material with cleaning fluid (and the reverse)
See "Optimizing (Calibrating) Print Heads" on page 4-56

Changing Model Materials Without Flushing

If you do not change the printing mode (High Speed / Super High Speed) you 
can replace the Model materials without flushing out the current materials. Use 
this option when the color or mechanical properties of the printed model are 
unimportant.

To change Model materials without flushing:

1. In the Material Replacement Options screen, click Advanced Settings.

2. In the Advanced Settings screen, select Manual slot selection and click 
Apply.

 
Figure 4-17    Manual slot selection
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3. When the Material Replacement Options screen opens, select the Replace 
materials without flushing check box and click Next.

Figure 4-18    Replace materials without flushing

4. In the confirmation message that appears, click Yes to continue. 

 
Figure 4-19    Replace without flushing confirmation message
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5. In the Cartridge Positioning and Process Progression screen, click Start.

Figure 4-20    Cartridge Positioning and Process Progression screen

6. Read the Warning message that appears, and click OK to continue.

 
Figure 4-21    Warning message
Material replacement begins.
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Advanced Settings

The Advanced Settings dialog box enables you to configure the Material 
Replacement wizard for special purposes. If necessary, click Advanced 
Settings in the Material Replacement Options screen before clicking Next.

By default, Automatic slot selection determines the best positioning for the 
material containers, based on materials currently in the system. This ensures 
minimum flushing of materials currently loaded.
Select Manual slot selection—             

• if there is a special need to load material containers in certain slot locations.             

• if you only want to change one of the material containers for a given material 
channel.

Some materials cannot replace certain other materials. If you attempt to do 
so, the wizard notifies you.

To select the container positions manually:

1. In the Material Replacement Options screen, click Advanced Settings.

2. In the Advanced Settings screen, select Manual slot selection, and click 
Apply.

 
Figure 4-22    Manual slot selection

3. In the Material Replacement Options screen, Both cartridges is selected for 
each position. To print with only one of the cartridges, clear the check box  and 
then select either the left (L) or the right (R) cartridge.

Figure 4-23    Manual material replacement

 



Stratasys J4100 User Guide 4 Operating and Maintaining the Printer

DOC-26000 Rev. C 4-24

4. After selecting the materials for the appropriate cartridge slots, the Cartridge 
Positioning screen appears. Place the cartridges in the materials cabinet as 
shown in this screen.

Figure 4-24    Cartridge Positioning screen (High Speed mode)
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Additional Flushing Cycles

The flushing cycle you select in the Material Replacement Options screen 
determines how thoroughly to flush out material currently in the system. After 
selecting the Economy cycle and completing the wizard, you might decide that 
you require a more thorough flushing, to ensure accurate model color. Or, you 
may notice that printed models are not satisfactory because they contain traces 
of the previous material. If so, you can flush out more material, so that the next 
models will be printed with pure material.

To perform additional flushing cycles:

➢  In the Advanced Settings screen, select Enable "flush again" options and 
click Apply.

 
Figure 4-25    Enable flush again options selected

The Material Replacement Options screen appears, where you can select the 
material(s) you need to flush again.
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Keeping the Printer in Idle Mode

Between printing jobs, the printer can be left unused for up to one week. If the 
printer will not be used for more than a week, use the Shutdown wizard to 
automatically perform the procedures that must be done before turning off the 
printer (see "Shutting Down the Printer" on the next page).

When the printer stops producing models, the printer software automatically 
reduces the temperature of the print heads, as follows:

After printing stops Mode Change in heating of 
print heads

first 15 minutes Standby 1 no change

next 1 minute Standby 2 -----

after Standby 2 Idle heating stopped

Note:   The printer mode is indicated in the upper section of the main printer 
interface screen (see the figures on pages 4-4,  and 4-10).

If, after printing a job, you know that the printer will not be used for 16 minutes or 
more, you can immediately turn off the heating of the print heads by putting the 
printer into Idle mode.

To put the printer into Idle mode:
➢  From the File menu (in the printer interface) click Exit.

Note:   The printer remains in Idle mode until you open the printer application 
and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this mode—
with the cover closed—for up to a week. For longer periods, shut down the 
printer by running the Shutdown wizard (see "Shutting Down the Printer" 
below). 
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Shutting Down the Printer

You only need to shut down the printer if it will not be used for 30 days or more. 
Otherwise, the printer can remain on, in Idle mode. However, if there is a need to 
turn off the printer sooner, use the Shutdown wizard to automatically perform the 
necessary processes before turning off the printer

The Shutdown process flushes printing materials from printer components. 
To avoid flushing out valuable material, make sure to print models at least 
once a week. Many printer operators use this opportunity to print customer 
samples or test models.

To properly shut down, the printer needs to perform several processes. These 
are controlled by the Shutdown wizard. Except for immediate servicing, do 
not attempt to shut down the printer by simply closing the computer 
interface (the printer-control application), and never disconnect power 
to the printer before completing this wizard.

Caution
Turning off the printer for an extended period without first running the wizard 
can cause serious damage to print heads and other expensive printer parts.

Depending on the length of time the printer will not be used, you can choose 
between a short shutdown procedure, and a more thorough procedure.

• Up to 30 days: The wizard empties the print block of Model and Support 
material, to prevent leaks. This takes about 10 minutes.

• More than 30 days: The wizard empties the print block, then flushes the 
system with cleaning fluid. This takes up to 75 minutes, and you must be 
present to load a container of cleaning-fluid  when instructed. 

To run the Shutdown wizard:

1. Start the Shutdown wizard from the Options menu.

Figure 4-26    Shutdown wizard, opening screen

2. Click Next.
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3. Select the option corresponding to the length of time that the printer will not 
be used—less or more than 30 days.

Note:   Before selecting More than 30 days, make sure that cleaning-fluid 
cartridges are available.

Figure 4-27    Shutdown options

4. In the next screen, verify that the tray is empty and click Next.             
The shutdown procedure begins.

Figure 4-28    Shutdown progress
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5. When the final wizard screen appears, close all open programs on both 
computers, and shut down the computers.

Figure 4-29    Final Shutdown wizard screen

6. After both printer computers shut down turn off the main power switch at the 
back of the printer (see Figure 4-2 on page 4-3).
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Maintaining the Printer

Performing routine maintenance tasks is essential for getting satisfactory results 
from your printer. Perform the tasks at specified intervals.

Routine Maintenance Schedule

Frequency Task For More 
Information

Before printing Clean the UV lamp lenses. "Cleaning the Print 
Heads, UV Lamp 
Glass, Roller and 
Wiper" on page 4-
37.

Before / after printing Check the UV lamp overheating indicator. See "UV Lamp 
Check         " on page 4-
33.

Before / after printing Routine cleaning of:
• print heads
• UV lamp glass lenses
• roller surface
• wiper
• build tray and surrounding area

"Cleaning the Print 
Heads, UV Lamp 
Glass, Roller and 
Wiper" on page 4-
37.

Weekly Clean the purge unit waste collector. See step 12 of 
"Cleaning the Print 
Heads, UV Lamp 
Glass, Roller and 
Wiper".

Weekly Perform the Pattern test. See "Pattern Test" 
on page 4-33.

Weekly Back up the printer's configuration files. See "Backing up the 
Printer 
Configuration" on 
page 4-36

Weekly Restart the printer computer.  
Weekly Clean the roller waste collector. See "Cleaning the 

Roller Waste 
Collector and 
Inspecting the 
Roller Scraper" on 
page 4-42.

Every 300 hours of printing (A 
reminder message appears.)

Calibrate the UV intensity. See "Testing and 
Calibrating the 
UV Lamps" on 
page 4-74.

Every 300 hours of printing Optimize the print heads. See "Optimizing 
(Calibrating) Print 
Heads" on page 4-
56.
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Frequency Task For More 
Information

Every 500 hours of printing Replace the wiper. See "Cleaning the 
Print Heads, UV 
Lamp Glass, Roller 
and Wiper" on 
page 4-37.

Every 700 hours of printing Replace the roller pump tubes. See "Replacing the 
Roller Waste 
Tubes" on page 4-
82.

Monthly, and after replacing print 
heads

Check the alignment of the print heads. See "Aligning the 
Print Heads" on 
page 4-49.

Monthly Remove and clean the print-head splash shield. See "Cleaning the 
Print-Head Splash 
Shield" on page 4-
54.

Monthly Clean debris from the Z-axis shaft with a vacuum 
cleaner.

 

Monthly Inspect the exhaust system (duct, fan, 
connections).

 

Monthly Calibrate the load cells. See "Calibrating the 
Load Cells" on 
page 4-87.

Every two years or every 2500 
hours of printing

 

Preventive maintenance visit by service engineer. Contact your 
Stratasys service 
provider.

 

Maintenance Counters

The printer computer application records the dates and frequency for each 
maintenance task. You can display the Maintenance Counters screen from the 
Options menu.

Figure 4-30    Selecting Maintenance Counters
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If there is a maintenance task due, this is indicated on the main interface screen.

 
Figure 4-31    Maintenance Required indicator
If this indicator appears, you can display the Maintenance Counters screen by 
clicking on it.

 

Figure 4-32    Maintenance Counters screen

The Maintenance Required indicator appears by default for most operator-
performed maintenance tasks. The check box under “User Warning” controls 
whether or not it appears when a particular task is due.

For maintenance tasks that are controlled by wizards, the dates and printing 
times are reset automatically when the relevant wizard is run and completed 
successfully. Manual maintenance tasks (for example, roller inspection and wiper 
replacement) are reset by clicking the reset button in the Maintenance Counters 
screen.
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UV Lamp Check         

A heat-sensitive label is fixed to the UV lamp covers as a warning against 
overheating. Its center changes from white to black if the temperature of the 
cover reaches 65°C (150°F). If this occurs, do not use the printer, and call your 
service provider. As a precaution, it is recommended that you check the label 
before and after printing. 

Figure 4-33    Heat-sensitive label on UV lamp cover

If the UV lamp continues to overheat, and the temperature around the lamp 
reaches 90°C (194°F), a heat fuse turns off the electricity to the power to the 
UV lamp and the motors for the X, Y, and Z axes. In the unlikely event that this 
occurs, the printer cannot be used until it is serviced by an authorized service 
engineer.

Pattern Test

The pattern test is the basic verification of the printer’s ability to produce quality 
models, since it demonstrates the condition of the nozzles in the print heads. 
Make sure, therefore, that you perform this test weekly, and whenever you 
suspect a printing problem.

To perform the pattern test:

1. Make sure that the build tray is empty.

2. Prepare a sheet of pink paper, A-4 or Letter size.

3. In the printer, tape the pink paper to the surface left of the build tray.

4. Press F3, or open the Options menu and select Pattern Test.



Stratasys J4100 User Guide 4 Operating and Maintaining the Printer

DOC-26000 Rev. C 4-34

Figure 4-34    Selecting Pattern Test

5. Click Yes in the Confirm dialog box to begin.

Figure 4-35    Pattern Test confirmation

6. If the build tray is not clear, click No in the following dialog box.

Figure 4-36    Build tray (Z) level adjustment
The build tray is lowered to prevent damage to models on the tray.
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The printer prints a series of lines on the test paper (see next figure).

Figure 4-37    Sample Pattern Test

7. Carefully inspect the test paper to see if there are missing lines. 
Too many missing lines, especially if they are in the same area, indicates that 
the quality of printing when producing models will be poor. If this is the case, 
see "Improving Print Quality" on page 4-37.

Note:   Acceptable model quality is subjective, and depends on the type and 
scale (size) of the models produced. As a rule, however, more than 10 
missing lines in one area of a column is considered unacceptable.

If you do not see many missing lines, but you suspect that there are faulty 
nozzles in a print head, you can print samples to inspect. See "Dynamic 
Nozzle Test" on page 4-98.
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Backing up the Printer Configuration

It is recommended that you periodically back up the printer's configuration files. In 
case of printer malfunction or the need to re-install the software on the printer 
computer, parameters can be restored from the backup. The backup also saves 
the printer's log and the calibration and maintenance history.

To back up the printer configuration files:

1. From the Options menu, select Collect Service Data.
or—

Press F2.

Figure 4-38    Selecting Collect Service Data from the Options menu

2. In the confirmation dialog box, click Yes.
A zip file is saved in this folder—
\STRATASYS_J4100\ServiceData

3. Copy this file to a location that is not on the printer computer (for example, a 
network folder or a USB drive).
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Improving Print Quality

If you suspect that print quality is poor, perform the Pattern Test (see "Pattern 
Test" on page 4-33). If the results are poor, use the following procedure to 
improve print quality.

If the results of the last pattern test are poor:

1. From the Options menu, select Purge Sequence, or press F4.

2. In the confirmation dialog box, click Yes.
The print heads are purged of Model and Support material, and the wiper 
removes excess material from them.

3. Repeat the purge sequence.

4. Perform the pattern test.

If the results of the pattern test are still poor:

1. Manually clean the print heads (see "Cleaning the Print Heads, UV Lamp 
Glass, Roller and Wiper" below).

2. Perform the purge sequence.

3. Perform the pattern test.

If the results of the pattern test are still poor:

1. Carefully clean the print heads again, making sure there is no residue left on 
them.

2. Perform the purge sequence.

3. Perform the pattern test.

If the results of the pattern test are still poor:
➢  Optimize the print heads and replace faulty print heads, if necessary (see 

"Optimizing (Calibrating) Print Heads" on page 4-56).
 

Cleaning the Print Heads, UV Lamp Glass, Roller and Wiper

Regular inspection and cleaning of the orifice plates on the bottom of the print 
heads prevents print nozzles from clogging. Cleaning the roller, wiper, and UV 
lamp glass are also important for maintaining quality printing. A wizard adjusts 
printer components to enable access to these key areas, and it guides you 
through the cleaning procedure. To maintain the printer in optimum condition, run 
the wizard after every print job, when you remove the model from the build tray. 
This procedure takes about 20 minutes.
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To clean the printer components:

1. Prepare—
❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
❒  disposable cleaning gloves 
❒  a supplied 3M sanding sponge
❒  a supplied cleaning cloth or equivalent 
❒  a mirror

2. Start the Cleaning wizard from the Options menu.

 
Figure 4-39    Options > Wizards menu

3. Make sure that the build tray is in the printer, and close the printer doors. 
Confirm this in the wizard screen and click Next.

 
Figure 4-40    Preparation check
After you indicate whether or not the build tray is clear, the printer moves 
components to the cleaning position. If there are models on the tray, it moves 
down to prevent damage to the models and the print block.
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4. When the following screen appears, open the printer.

Figure 4-41    Wizard screen during cleaning tasks

Warning: Hot Surface
The print head orifice plates (bottom surface) may be hot. Do not touch them 
with your bare hands, and proceed with caution.

5. Place the mirror on the build tray. 

6. Put on the gloves.

Caution
Uncured printing material on the print heads might cause skin irritation. Use 
disposable cleaning gloves to protect your hands.

7. Soak the cleaning cloth with alcohol.
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8. Clean the orifice plates, with a back-and-forth motion. Use the mirror to make 
sure that you have removed all of the residue material.

Figure 4-42    Cleaning the heads

Once a month, remove and clean the print-head splash shield. (See step 4 on 
page 4-55.)

9. Using the supplied cleaning sponge, clean the glass lens on both UV lamps . 

10. Open the service window on the left side of the printer to access the wiper. 

11. Using the alcohol-soaked cleaning cloth, remove any material remaining on 
the wiper and the surrounding area. 

12. Remove any pieces of waste material collected in the purge unit. If 
necessary, remove the waste collector to clean it. Wipe the rubber seal.

 
Figure 4-43    Removing the purge unit waste collector
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Note:  When returning the waste collector to the purge unit, make sure to insert it 
as shown.

13. Inspect the wiper.
If the wiper is scratched, torn or worn, or if you cannot clean it completely, 
replace it.

a. Grasp it and pull it up and out of its bracket. 
b. Insert the new wiper blade, making sure that it is straight and secured well 

on both sides. 

14. Select the confirmation check boxes in the wizard screen (see Figure 4-41) 
and click Next.

15. Activate the roller, so that it rotates while you clean it.

Figure 4-44    Roller-rotation activation

16. With a cleaning cloth soaked with alcohol, clean the roller surface, as it is 
rotating.

Caution
Use caution when cleaning the rotating roller. Use a cleaning cloth or the 
supplied UV sanding sponge.

17. When the roller is clean, select the confirmation check box in the wizard 
screen and click Next.
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The roller stops rotating when you click Next.

18. Remove the cleaning materials from the printer and close the printer doors.

19. Select the confirmation check boxes in the wizard screen and click Next.
The head-purge cycle begins. When this is complete, the final wizard screen 
appears.

Figure 4-45    Cleaning wizard—final screen

20. Click Done to close the wizard.

Cleaning the Roller Waste Collector and Inspecting the Roller Scraper

The roller waste collector removes waste material scraped from the roller. 
Suction removes this waste to the printer’s waste container.

This assembly should be cleaned weekly to prevent a blockage in the tubes 
leading to the waste container, so that waste material does not overflow into the 
printer.

To clean the roller waste collector:

1. Prepare—
❒  M2.5 and M2 Hex (Allen) keys
❒  disposable cleaning gloves
❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
❒  cleaning cloth
❒  cotton swabs (Q-tips or similar)
❒  mirror
❒  flashlight

2. From the Option menu, select Go to Head Inspection Position.

3. Put on the gloves.
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4. Remove the right UV-lamp assembly:
a. Disconnect the UV power cable and the fan power cable.

Figure 4-46    Disconnecting the right UV assembly

b. Remove the screw that secures the right UV lamp, and then pull and lift 
up the UV lamp.



Stratasys J4100 User Guide 4 Operating and Maintaining the Printer

DOC-26000 Rev. C 4-44

5. Detach the UV bracket from the print block.
a. Loosen screws A, B and C.
b. Remove screws D and E.

 
Figure 4-47    UV bracket attached to the print block

c. Slide the bracket upward, to separate it from the print block.

Figure 4-48    UV bracket detached from the print block

6. Loosen the two screws securing the suction tube on the print block.

Figure 4-49    Lifting the suction tube

7. Lift the suction tube to secure it in a raised position.
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8. Remove the two screws securing the covering of the roller waste collector 
and remove it.

Be very careful to save the covering screws. These are special screws; if they 
are lost, you need to order replacements.

Figure 4-50    Removing the roller waste collector screws

9. Remove the covering by pulling it out, and then lower it.

10. Clean the roller waste collector and the scraper blade surface using cotton 
swabs. Make sure to remove any remaining printing materials.

Figure 4-51    Cleaning the roller waste collector

Before replacing the covering, you can check the effectiveness of the roller 
scraper—see below.

To check the effectiveness of the roller scraper:

1. Put on the cleaning gloves.

2. Wet a cloth with isopropanol.

3. Use the cloth to wet the bottom of the roller.

4. Turn the roller slowly with your hand. As the blade scrapes the roller, make 
sure the isopropanol is spread evenly over the entire length of the blade.

5. Inspect the roller. If it is not dry, replace the blade. (See "Replacing the Roller 
Scraper" on the next page.)
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6. Before returning the roller waste collector to the print block, make sure that 
the pins are clean. 

Figure 4-52    Roller waste collector pins

To re-assemble the components:

1. Return the roller waste collector to the print block and screw on the covering 
(see Figure 4-50 on the previous page).

2. Loosen the screws securing the suction tube.

Figure 4-53    Positioning the suction tube

3. Lower the suction tube so that the hole in the panel behind the tube is visible, 
and tighten the screws to secure the tube. 

4. Attach the right-UV-lamp assembly to the print block and reconnect the UV 
power and fan cables.

Replacing the Roller Scraper

You should replace the roller scraper blade—
• after 1,000 hours of printing.
• if it does not effectively keep the roller clean.

You should periodically test the effectiveness of the roller scraper when you 
clean the roller waste collector. See "Cleaning the Roller Waste Collector and 
Inspecting the Roller Scraper" on page 4-42.
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To replace the roller scraper:

1. Prepare—
❒  a new roller scraper blade
❒  a Phillips 1x75 mm screwdriver
❒  a 2.5-mm and a 2-mm hex (Allen) key

2. Remove the right UV lamp and the roller waste collector covering (see steps 
4 to 8  on page 4-43).

3. Loosen the two screws securing the roller waste collector and pull it out.

Figure 4-54    Removing the roller waste collector

4. Remove the screws that secure the roller scraper assembly. 

Figure 4-55    Removing the roller scraper screws
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5. Remove the scraper blade and discard it.

Figure 4-56    Removing the old roller scraper blade

6. Place the new scraper blade onto the pins in the holder, as shown. 

Figure 4-57    Inserting the new roller scraper blade
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7. Insert and tighten the roller scraper blade screws.

Important:
 l Tighten the screws in the order shown in Figure 4-58.
 l Use the new screws supplied in the replacement kit

Figure 4-58    Tightening the roller scraper screws

8. After tightening the screws, inspect the blade and make sure that it is straight. 
If necessary, loosen the screws and tighten them again, evenly.

9. Return the roller waste collector assembly and the right UV lamp to the print 
block. (See steps 6 to 8 on page 4-43 in "Cleaning the Roller Waste Collector 
and Inspecting the Roller Scraper".)

Aligning the Print Heads
You should check the alignment of the print heads— 

• once a month
• after replacing one or more heads
• if model quality is not acceptable even after cleaning the orifice plate on the 

bottom of the print block (see "Cleaning the Print Heads, UV Lamp Glass, 
Roller and Wiper" on page 4-37).

This procedure takes about 20 minutes.

To check the alignment of the print heads:

1. Prepare—
❒  a transparency sheet, A-4 or Letter size
❒  any type of adhesive tape, to fasten the transparency sheet to the build 

tray

2. Start the Head Alignment wizard from the Options menu.
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3. When the following screen appears, place the transparency on the build 
tray—next to the left and rear edges of the tray (see below).

Figure 4-59    Transparency confirmation

Figure 4-60    Positioning the transparency on the build tray

4. Make sure that the transparency sheet is lying flat, and tape it to the tray.

5. Close the printer cover.

6. In the wizard screen, select the check box to confirm that the transparency 
sheet is secured to the build tray, and click Next.
When you click Next, the printer prints the head alignment test on the 
transparency. When printing is finished, the following screen appears.

Figure 4-61    Head Alignment wizard—steps 7–9

7. Open the printer and remove the transparency.
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The transparency sheet is printed with sets of vertical lines in seven columns, 
each showing the results from a different print head.

Figure 4-62    Sample head-alignment test

Note:   There is no column for head H7 because its alignment is used as a 
reference for aligning all other heads.

8. For each column of lines, use a magnifying glass or loupe to inspect pairs of 
consecutive rows printed on the transparency to see where the vertical lines 
align.

Figure 4-63    Comparing rows of alignment lines

Note:   It does not matter which pair of lines you inspect, since they were all 
printed by the same head. Choose a pair of clearly printed lines for the 
inspection. (Since some nozzles may not print clearly, you may have to 
inspect several pairs of lines to properly view the alignment.)

Optimum head alignment is shown when the fourth lines in the upper and 
lower rows are aligned, as in Figure 4-63. In the example shown, no change 
to the head alignment is necessary. If other lines in the set are aligned, you 
need to change the alignment of that head—in the next wizard screens.

9. In the wizard screen shown in Figure 4-61, select the Transparency removed 
check box, and click Next.
The first in a series of alignment screens appears.

Figure 4-64    Head alignment selection
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10. In the head-alignment screen, select the number that indicates which lines 
align in the upper and lower rows of a pair on the transparency (counting from 
the left) for this print head.

Note:   Because the alignment of the fourth lines is optimum, the number “4” 
is selected, by default, in the wizard screen. This does not change the head 
alignment. If you select other numbers, the wizard adjusts the head 
alignment, accordingly.

11. Click Next to display the next head alignment screen, and again select the 
number representing the most closely aligned vertical lines on the 
transparency for that print head.
When you have finished aligning all of the heads, the following screen is 
displayed.

Figure 4-65    Parameter update confirmation

12. Continue as follows:
❒  To make the alignment changes in the printer, make sure that Update 

system with new parameters is selected, and click Next. 
❒  To recheck the alignment test results before making the alignment 

changes in the printer, click Previous.
❒  If you do not want to make alignment changes in the printer at this time, 

select Keep previous parameters, and click Next.
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13. In the following screen, you can choose to either repeat the head alignment 
procedure, or close the wizard. 

Figure 4-66    Repeat head alignment option

❒  If the most closely aligned vertical lines for a print head were at either 
extreme, choose Repeat the test, then click Next. 
The additional transparency test will show if the heads are now properly 
aligned, and—if not—the wizard will allow you to “fine tune” the 
alignment.

❒  If the vertical lines for the print heads were not aligned at either extreme,  
choose End this wizard, then click Next.
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Cleaning the Print-Head Splash Shield

To prevent excess printing material from accumulating around the print heads, a 
splash shield is installed on the bottom of the print block. Remove the shield and 
clean it once a month, when cleaning the print heads (see "Cleaning the Print 
Heads, UV Lamp Glass, Roller and Wiper" on page 4-37).

To remove the print-head splash shield:

1. Run the Cleaning wizard from the Options menu.
When the printer moves components to the cleaning position, the following 
screen appears.

Figure 4-67    Wizard screen during cleaning tasks

2. Open the printer and place a mirror on the build tray.

3. Put on cleaning gloves.

Caution
Uncured printing material on the print heads might cause skin irritation. Use 
disposable cleaning gloves to protect your hands.
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4. Using a 2-mm hex (Allen) key, remove the screws to remove the splash 
shield.

Figure 4-68    Print-head splash shield installed on the print block

Figure 4-69    Removing the print-head splash shield

Warning: Hot Surface
The print head orifice plates (bottom surface) may be hot. Do not touch them 
with your bare hands, and proceed with caution.

5. Soak a cleaning cloth with 90% alcohol and clean the splash shield.

6. Return the splash shield to the print block and secure it with four (4) screws.

After cleaning the print heads and the splash shield, continue with step 9 in 
the daily cleaning routine (see "Cleaning the Print Heads, UV Lamp Glass, 
Roller and Wiper" on page 4-40).
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Optimizing (Calibrating) Print Heads

The condition of the print heads directly affects the quality of printed models. To 
maintain optimum printing, you should routinely test the print heads, and calibrate 
them to the best working configuration possible by running the Head 
Optimization wizard every 300 hours of printing.

You also need to calibrate the print heads in these cases:
• after changing the printing mode

• after replacing Vero with Digital ABS or Agilus30 Model materials (and the 
reverse)

• after replacing the Support material with cleaning fluid (and the reverse)
If, during the optimization process, the wizard determines that a print head is 
faulty—or that it is negatively affecting layer uniformity with the current head 
configuration—the wizard instructs you to replace it. If this happens, you can 
continue the wizard to replace the print head, or abort the wizard, to replace the 
head at another time. 

Run the Head Optimization wizard every 300 hours of printing or whenever 
the condition of print heads is negatively affecting the quality of printed 
models, or if you suspect that there is a problem with one or more of the print 
heads.

Note: To accurately test and calibrate print heads, they must be clean. If 
necessary, run the Cleaning wizard before beginning this procedure.

To test and calibrate the print heads:

1. Prepare—
❒  disposable cleaning gloves (any clean, powder-free protective gloves)
❒  pink paper
❒  the Missing Nozzles ruler
❒  the scale supplied for use in the Head Optimization wizard
Important:  Before beginning this procedure, ensure that the scale is 
calibrated and at least partially charged. 
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2. Start the Head Optimization wizard from the Options menu.

Figure 4-70    Starting the Head Optimization wizard

3. In the opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.

4. Read the conditions, select I Agree and click Next.

5. In the following screen, select Continue with Head optimization if you 
have recently cleaned the print heads. Otherwise, cancel the wizard and run 
the Cleaning wizard.

Figure 4-71    Clean print heads screen
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6. In the following screen, make sure Optimize all print heads is selected, and 
click Next.

Figure 4-72    Procedure selection screen

7. Select the printing mode for which you want to optimize the print heads and 
click Next.

Figure 4-73    Printing mode selection

Note: The mode options depend on the materials loaded in the printer.

8. Check that the build tray is empty and that the printer doors are closed. 
Confirm this in the wizard screen, and click Next.

Figure 4-74    Preparation check
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After warming the print block and turning on the UV lamps, the printer prints a 
frame on the build tray for positioning the scale.

Figure 4-75    Scale positioning frame on the build tray

9. When the “Preparation for Pattern Test” screen appears, open the printer 
and tape a sheet of pink paper to the surface left of the build tray, as shown 
below. 

Figure 4-76    Pattern Test paper positioned next to the build tray

10. Close the printer doors and click Next in the wizard screen.
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11. When the following screen appears, open the printer and remove the Pattern 
Test paper.

Figure 4-77    Enter Missing Nozzles screen

12. Carefully inspect the Pattern Test paper with the Missing Nozzles Ruler to 
see if there are missing lines.

Figure 4-78    Inspecting the Pattern Test
Each missing line represents a faulty nozzle in the print head.

13. In the Missing Nozzles screen, enter the number of missing nozzles for each 
print head and click Next.
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14. The wizard continues according to the number of missing nozzles you 
entered. 
❒  If there are too many missing nozzles for acceptable printing, the wizard 

instructs you to replace the defective print head(s). You can do this now, 
or abort the wizard.

If you are prepared to replace print heads now, the wizard guides you 
through the procedure when you click Next. Make sure you have 
replacement heads and the required tools (see page 4-65). Then, 
continue with "Preparing the Print Block" on page 4-66.

Figure 4-79    Head replacement due to missing nozzles
❒  If the number of missing nozzles in all print heads is acceptable, the 

wizard continues with the head optimization process (below).

15. Set up the scale in the printer by performing the steps listed in the wizard 
screen.

Figure 4-80    Setting up the Head Optimization scale
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16. After confirming all of the items listed in the wizard screen, click Next.
Printing material (resin) is jetted from each head and its weight is 
automatically recorded. Then, the following screen appears.

Figure 4-81    Emptying the resin container

17. Open the printer. Carefully remove the resin container from the scale and 
empty it into the purge unit. Then return the container to the scale.

Caution: The resin in the container is uncured
 l To prevent contact with skin, wear neoprene or nitrile gloves.
 l Dispose of uncured resin in accordance with applicable regulations. By 

emptying the container into the purge unit, the resin is stored in the printer’s 
sealed waste container.

18. Close the printer cover, confirm the items listed in the wizard screen, and click 
Next.
The printer cures the resin in the container.

19. When the following screen appears, open the printer and remove the scale. 

Figure 4-82    Remove Scale confirmation screen

20. Confirm the items listed in the wizard screen, and click Next.
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The wizard uses the data collected to analyze the condition of the print heads 
and optimize them so they print models with a uniform layer of material. 

❒  If the heads are in satisfactory condition, the following wizard screen 
appears.

Figure 4-83    Final wizard screen, after optimizing print heads
❒  If the wizard determines that a print head is faulty—or that it is negatively 

affecting model quality with the current head configuration—you need to 
replace it. Indicate whether or not you want to do so now.

Figure 4-84    Defective print heads found

• Select Replace defective head(s) if you are prepared to replace the 
print heads now (see below). 

or—

• Select Abort wizard if you want to replace the print heads at another 
time.

Replace print heads only after consulting with an authorized Stratasys service 
provider.
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To replace print heads, you need these tools and materials:

❒  replacement print head(s)
❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
❒  disposable cleaning gloves (supplied with the print head; or use any clean, 

powder-free protective gloves)
❒  a supplied cleaning cloth or equivalent
❒  a mirror
❒  a 4-mm hex (Allen) key
❒  a small Phillips screwdriver
❒  the Missing Nozzles ruler
❒  the scale supplied for use in the Head Optimization wizard (Weight Test)
Important:  Before beginning this procedure, ensure that the scale is 
calibrated and at least partially charged. 

If you are replacing print heads now, the wizard guides you through the 
procedure when you click Next. Continue with "Replacing Print Heads" below.

Replacing Print Heads

The condition of the print heads directly affects the quality of printed models. You 
may need to replace a print head if one or more of the following symptoms 
occurs:

• The Head Optimization wizard determines that a print head is defective. (See 
"Optimizing (Calibrating) Print Heads" on page 4-56.)

• There are noticeable grooves in the surface of printed models.

• Visual inspection of the head reveals that its surface is damaged—peeling or 
bubbles in the nozzle area.

• The printer interface displays a warning or malfunction message relating to a 
print head—
❒  Head Heater temperature timeout
❒  Head Heater thermistor open
❒  Head Heater thermistor short

Replace print heads only after consulting with an authorized Stratasys service 
provider.

The Head Optimization wizard guides you through the procedure of replacing a 
print head, and configures printer components to enable you to perform it. Only 
replace a print head with the aid of the wizard.



Stratasys J4100 User Guide 4 Operating and Maintaining the Printer

DOC-26000 Rev. C 4-65

The entire print-head replacement procedure takes 75—90 minutes, and 
consists of the following phases: 

A. Identifying the head(s) needing replacement. 
This is normally done by the Head Optimization wizard. Otherwise, evidence 
of physical damage to the head surface or a malfunction message indicates 
which head needs replacing.

B. Preparing the print block for head replacement.
This is done automatically when you run the wizard.

C. Removing the defective print head. 
D. Installing a new print head.
E. Optimizing the print heads (done automatically by the wizard).
F. Performing head alignment.        

 

To replace a print head:

1. Prepare—
❒  replacement print head(s)
❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
❒  disposable cleaning gloves (use clean, powder-free gloves)
❒  lint-free cleaning cloths
❒  a mirror
❒  the scale supplied for use in the Head Optimization wizard (Weight Test)
❒  the Missing Nozzles ruler

Important:  Make sure that you have these items and that the scale is 
calibrated and at least partially charged before continuing.

2. Start the Head Optimization wizard from the Options menu (see the figure on 
page 4-56).

3. In the opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.

4. Read the conditions, select I Agree and click Next.
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5. In the following screen, select Continue with Head optimization if you 
have recently cleaned the print heads. Otherwise, cancel the wizard and run 
the Cleaning wizard.

Figure 4-85    Clean print heads screen

6. In the following screen, select Replace faulty heads, and click Next.

Figure 4-86    Procedure selection screen

Preparing the Print Block

7. Select the print head(s) needing replacement, and click Next.

Figure 4-87    Head selection screen
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The printer heats and empties the print block, and prepares the printer. (This 
should take up to 15 minutes.)

The following screen appears when the printer is ready for you to replace 
print heads.

Figure 4-88    Printer ready for head replacement

8. Put on the protective gloves and open the printer cover.
Note: The printer disconnects power to the heads for your safety.

Removing the Defective Head

9. On the front of the print block, loosen the screws that secure the cover 
protecting the print-head driver cards. 

Figure 4-89    Loosening the driver-card cover screws

10. Lift up the cover.
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11. Loosen the screws that secure the driver-card bracket, and lower the bracket.

Figure 4-90    Loosening the driver-card bracket screws

12. Release the driver-card support.

Figure 4-91    Releasing the driver-card support
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13. Remove the driver card by releasing the latch at the points shown.

Figure 4-92    Releasing the driver-card latch

14. Release the upper and lower screws that secure the print head in the block. 
(If necessary, you may use a 4-mm hex (Allen) key to loosen the screws.)

Figure 4-93    Releasing the print-head locking screws
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15. Press down on the upper and lower locking screws to release the print head, 
and remove it from the bottom of the print block.

Figure 4-94    Releasing the print head

16. Make sure that along with the head, you remove the four (4) rubber O-ring 
seals.

Figure 4-95    O-ring seals on the print head
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Important
If the seals are not removed with the head, they are probably stuck to the print 
block housing. If so, remove them.

Figure 4-96    Making sure the O-rings are not stuck to the print block

Installing the New Head

17. Place four (4) O-ring seals in the replacement head (see Figure 4-95 on the 
previous page).

18. Position the head in the print block, making sure that the location pins are in 
place. 

Note: Make sure to insert the head with the contacts on the driver card facing 
the print block.

19. Tighten the upper and lower screws that secure the print head in the print 
block (see Figure 4-94 on the previous page).

Note: Hand-tighten these screws. To avoid over-tightening, do not use a hex 
(Allen) key.

20. Insert the driver card into its socket, and secure the card.

Figure 4-97    Securing the driver card

21. Lower the protective cover and tighten the screws to secure it.
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22. In the Replace print heads screen, select the check box to confirm that you 
have replaced the head(s), and click Next.

Figure 4-98    Head replacement confirmation

23. With your fingers, make sure that the new head is level and even with the 
other heads.

Figure 4-99    Checking the level of the new head

24. Confirm that the heads are level by selecting the check box in the following 
wizard screen, and click Next.

Figure 4-100    Installation-check screen
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25. In the next wizard screen, confirm that you have removed all tools and objects 
from the printer.

Figure 4-101    Cleared-tray confirmation screen

26. Close the printer doors.
The wizard continues by heating the heads, then filling and purging them.    

If installation problems are detected, the wizard alerts you and instructs you 
how to continue (see "Installation Problems" below).

27. After replacing print heads, you should run the wizard again, to optimize the 
new heads, and to make sure that they are optimized for printing with the 
other heads. In the final wizard screen, select Optimize all print heads and 
click Next.

Figure 4-102    Final wizard Screen

Installation Problems

If the printer detects that there is a problem after you install print heads, a 
relevant warning screen appears.

➢  If the printer software does not detect the replaced head, release the print 
head card and re-insert it. (see "Removing the Defective Head" on page 4-
67). 
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➢  If the replacement head was not calibrated by Stratasys, remove the head 
and replace it with another one. 

Figure 4-103    Invalid-head warning
Contact your Stratasys service provider about the uncalibrated head.

Testing and Calibrating the UV Lamps

The level of UV radiation from the lamps used for curing models can change over 
time. To ensure optimum curing of models during printing, a pop-up message 
reminds you to test the lamps and calibrate the level of UV radiation after every 
300 hours of printing. You do this by running the UV Calibration Wizard.

To measure the UV radiation, you need:

• Stratasys TOL-03005-S (UV sensor and cable)
or—

• a stand-alone UV radiation meter, approved for use with the printer
The wizard compares the measured radiation to the recommended radiation 
level for each of the lamps, at each printing mode. 

When calibrating the lamps, the wizard attempts to adjust the radiation level, if 
necessary.

• If the reading is within the acceptable range, the wizard continues to the next 
phase. 

• If further adjustment is necessary, the current phase is repeated. 

• If the level of UV radiation is too low to be properly adjusted, the wizard 
continues to the next phase, but the final wizard screen indicates that the 
lamp’s radiation for the printing mode is unacceptable.

Before testing and calibrating the UV lamps: 
 l Make sure the glass lens on each of the UV lamps is clean. For easy access, 

run the Head Cleaning Wizard, and use the special sanding sponge supplied 
in the Start-Up Kit.

 l Make sure that the glass over the UV radiation sensor is clean.
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To test and calibrate UV lamp radiation:

1. Start the UV Calibration Wizard from the Options menu.

2. In the following screen, select Calibrate UV Intensity to adjust the lamp’s 
radiation level to the acceptable range.

Figure 4-104    UV Test/Calibration selection

3. In the following screen, select the UV sensor and measuring device to be 
used.

Figure 4-105    UV device selection

UV Measuring Device 
When you use the Stratasys UV sensor box (TOL-03005-S), you connect it to 
the printer. The wizard automatically measures and calibrates the UV 
radiation.

If you use a stand-alone UV radiation meter, you need to manually enter the 
readings from the meter in the wizard screens.
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4. Make sure that the build tray is empty. Confirm this in the wizard screen and 
click Next.

Figure 4-106    Printer preparation

➢  When using a Stratasys UV sensor box that you connect to the printer 
(TOL-03005-S), continue with "UV Sensor Connected to Printer" on the next 
page.

➢  When using a stand-alone UV radiation meter, continue with "External UV 
Meter" on page 4-78.
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UV Sensor Connected to Printer

The following steps apply when using the Stratasys UV sensor box that you 
connect to the printer. They do not apply when using a  UV external radiation 
measuring device.

1. To synchronize the wizard and the UV sensor, enter the CF number from the 
label on the back of the UV sensor box.

Figure 4-107    UV sensor synchronization

Figure 4-108    Label on the bottom of the UV sensor box

2. Click Next.
The build tray lowers so you can connect the UV sensor box.
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3. Position the UV sensor box in the lower-right corner of the build tray.

4. Confirm the items listed in the wizard screen and click Next.

Figure 4-109    Sensor positioning
Continue with "UV Measurement        " on page 4-80.

External UV Meter

The following steps apply when using a stand-alone UV meter. This section does 
not apply when using the Stratasys UV sensor box connected to the printer.

1. When the following screen appears, open the printer and place the UV 
sensor (probe) at the rear edge of the tray, in the center.

Figure 4-110    Sensor placement screen
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2. Lead the cable out of the printer so that you can close the printer, and tape it 
down to make sure that it does not interfere with the moving print block.

 
Figure 4-111    Correct UV-sensor placement

3. Close the printer, while checking that the sensor does not move out of 
position.

4. Set the UV meter to measure mJ/cm2.

5. Set the range on the meter to 2,000.

6. Connect the cable from the sensor to the UV meter. 

7. Turn on the UV meter, and wait until “0 0 0.0” appears on the display.

8. In the wizard screen, confirm that the sensor is positioned correctly, and click 
Next.

Continue with "UV Measurement        " on the next page.         
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UV Measurement        

The UV lamps power up and stabilize. (This takes several minutes.) Then, the 
print block passes over the sensor and the wizard compares the measured 
radiation to the recommended level for each UV lamp. During this process, which 
takes 20–40 minutes, you need to monitor the progress as displayed in the 
wizard screen.

Figure 4-112    UV measurement progress
When using a stand-alone radiation meter (not the Stratasys UV sensor box 
connected to the printer): Reset the meter and enter the reading (measurement) 
when you are prompted to do so.

 
Figure 4-113    UV Measurement dialog box
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If the UV level measured is not acceptable, the wizard calibrates the UV lamp by 
adjusting the current supplied to it, and then tests it again.

When all UV tests have finished, the results are displayed, showing the condition 
of the lamps after calibration (see Figure 4-114 below).

Figure 4-114    Results and condition of UV lamps after calibration

After examining the UV calibration results:

1. Click Next.

2. Remove the UV sensor and close the printer cover. After confirming the items 
listed in the wizard screen, click Next.

Figure 4-115    UV sensor removal
If the results are not acceptable for quality printing, this is indicated in the final 
wizard screen.
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Figure 4-116    Final UV Calibration Wizard screen

Replacing the Roller Waste Tubes

As routine maintenance, you should replace the tube in the roller waste pumps 
every 700 hours of printing. 

Note: Older printers have one roller waste pump; newer installations and 
upgraded printers have two pumps.

To replace the roller waste tube:

1. Prepare—
❒  two cleaning cloths
❒  a Norprene® tube (supplied in the Start-Up Kit)

2. Make sure that the printer is either in Standby2 or in Idle mode.

3. Press F8.
or—
From the Options menu, select Go to Head Inspection.
The print block moves forward and the build tray lowers.
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4. Open the printer doors and locate the roller waste pumps.

Figure 4-117    Roller waste pumps

5. Release the tube latch on the pump, as shown below.

Figure 4-118    Releasing the tube latch
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6. Separate the tube holder from the pump assembly.

Figure 4-119    Tube holder removed from pump assembly

7. Remove the tube from the tube holder and save the two parts of the clamp for 
re-assembly.

8. Carefully detach the tube at both ends. Use the cleaning cloths to prevent 
material leaking from the tubes.

9. Discard the old tube and the cleaning cloths.

These items contain uncured printing material. Dispose of them in 
accordance with environmental and safety requirements.

10. Attach the ends of the new tube.

11. Place the tube clamp onto the tube as before, and insert the tube into the tube 
holder, making sure that the flat surface of the clamp faces outward.

Figure 4-120    Left: Tube clamps; Right: Tube inserted into tube holders
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12. Insert the tube holder into the pump assembly, making sure that the side with 
the clamp is on the side of the pump marked SUCTION.

Figure 4-121    Tube clamp on SUCTION side of pump

13. Close the tube latch.

If there are two roller waste pumps in the printer, replace the tube in both 
pumps.
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14. From the Options menu, select Maintenance Counters.

15. Scroll to the General Pumps section and locate the counters for the roller 
waste pump tubes ("Roller Tube Left" / "Roller Tube Right"). 

Figure 4-122    Maintenance Counters screen

16. Click Reset for these counters.
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Calibrating the Load Cells

Load cells are sensors that measure the weight of the material containers and 
the waste container in the printer. It is important that you periodically check that 
the weight measurements are accurate to prevent unnecessary waste of printing 
materials or printer malfunctions.

To calibrate load cells:

1. Start the Load Cell Calibration wizard from the Options menu.

2. In the following screen, select one or more load cells that you want to 
calibrate. 

Figure 4-123    Load cell selection

3. Make sure that there are no containers on the load cells that you want to 
calibrate, and click Next.

4. In the next wizard screen, observe the numbers and wait until the weight level 
is relatively stable—two units above or below the average level shown.

Figure 4-124    Weight stabilization

5. Select the check box, and click Next.
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6. Click Done in the final wizard screen.

Figure 4-125    Final wizard screen

Replacing the UV Lamps

The UV lamps used for curing models have a long, but limited, working life. You 
can test and adjust their effective power with the UV Calibration wizard (see 
"Testing and Calibrating the UV Lamps" on page 4-74). If you need to replace a 
UV lamp bulb or UV reflector, follow these instructions: 

To replace the UV lamp bulb or UV reflector:

1. Make sure the printer is in offline mode.

Figure 4-126    Offline mode indicator (red)
The online/offline button at the bottom of the printer interface should be red. If 
not, click it to switch the printer to offline mode.

Warning
Before continuing, make sure that the safety interlock is not defeated, and that 
the UV lamp is not hot.
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2. Start the UV Lamp Replacement wizard from the Options menu. 

Figure 4-127    Selecting the UV Lamp Replacement wizard

3. Make sure that the build tray is empty, and confirm this in the wizard screen. 
Then, close the printer, and click Next.

Figure 4-128    Tray confirmation
The axes move to the “home” position.
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4. Select the UV lamp(s) to be replaced and click Next.

Figure 4-129    UV lamp selection screen

5. Disconnect the UV-lamp power connector and the UV heat fuse connector.

Figure 4-130    Disconnecting the UV lamp 

Note: Do not disconnect the power connection to the cooling fans.
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6. Loosen the screw securing the UV lamp cover (A), and pull the cover up (B), 
then out (C).

Figure 4-131    Removing the UV lamp cover             

7. Pull the UV reflector out of the UV housing.

Figure 4-132    Removing the UV lamp reflector

8. Using a 2.5-mm hex key, remove the UV lamp clamp (2 screws).

Figure 4-133    Removing the UV lamp clamp
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9. Remove the UV lamp bulb from the UV reflector.

Figure 4-134    Removing the  UV lamp bulb

10. Before continuing, inspect the spring-loaded pins. If there are burn marks 
around the pins or if the pins are loose—their springs are not functioning 
properly—and do not support the bulb, continue with step 15, to replace the 
UV reflector. 
Otherwise, continue with step 8 to replace the UV bulb.

Figure 4-135    Spring-loaded pin 
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11. Using the polyurethane tube provided in the kit, push the new UV lamp bulb 
into the UV reflector. Make sure that the tip on the bulb is facing the slot.

Figure 4-136    Pushing the new UV bulb into the UV reflector

12. Twist the tube by 180° (a), and continue to insert the UV lamp bulb into the 
UV reflector (b).

Figure 4-137    Twisting the tube and inserting the UV lamp

13. Use the UV lamp clamp to insert the lamp into place in the UV reflector.
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Figure 4-138    Pushing the UV lamp into place

14. Using a 2.5-mm hex key, secure the clamp to the UV reflector, and continue 
with step 25.

Figure 4-139    Attaching the UV lamp clamp

15. Inspect the new UV reflector, and make sure that a black strip is attached to 
the inside of it. If not, install one—on the side of the reflector opposite (not 
next to) the print block.

Note:  Extra black strips are included in the printer Start-Up Kit. If necessary, 
you can remove the black strip from the old reflector and install it in the new 
reflector (as long as the black paint has not faded).

16. Discard the old UV reflector and lamp.

Dispose of the used UV lamp in accordance with environmental and safety 
requirements.
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Warning: Broken UV lamp hazard
UV lamps contain mercury. Deal with broken lamps with caution.
 l Ventilate the room thoroughly.
 l Use protective gloves when collecting mercury and lamp components.
 l Remove spilled mercury with a method that prevents the generation of 

mercury vapor, such as a syringe, packing tape or paper. 
 l Place the broken lamp, mercury and contaminated materials in an air-tight, 

non-metallic container.

17. Insert the UV reflector unit into the housing, next to the print block.

Figure 4-140    Print block and UV lamp assembly, showing correct 
placement of black strip

18. Replace the UV lamp cover by inserting it into the slot on the bottom of the 
housing, and tighten the securing screw on top.

Figure 4-141    Replacing the UV lamp cover
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19. Reconnect the power and heat fuse connectors.

Figure 4-142    Connecting the UV lamp

20. In the wizard screen, confirm that you have replaced the UV lamp(s) and that 
the black strip is attached, then click Next.

Figure 4-143    UV-installation confirmation
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The wizard operates the UV lamps and checks if their power is within the 
acceptable range for each printing mode. 

Note:   The mode currently being checked appears in the lower-left corner of 
the printer interface.

Figure 4-144    Status during UV lamp check
After replacing a UV lamp, it is recommended that you calibrate its power for 
the various printing modes. The next screen allows you to continue to the UV 
Calibration wizard (see "Testing and Calibrating the UV Lamps" on page 4-
74).

Figure 4-145    Calibration selection screen
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Dynamic Nozzle Test

Perform the Dynamic Nozzle Test if you suspect that poor quality in printed 
models is caused by clogged or faulty nozzles in the print heads—even if this is 
not indicated by the Pattern Test. 
The Dynamic Nozzle Test prints eight (8) samples on the build tray, which you 
can then visually inspect. Printing the samples takes about 20 minutes.

To run the Dynamic Nozzle Test:

1. Make sure that the build tray is clear (empty).

2. From the Options menu, select Dynamic Nozzle Test, and then select the 
appropriate test for the current printing mode.

Figure 4-146    Selecting Dynamic Nozzle Test from the Options menu

3. When the samples are printed, check if they have visible gaps.

…………
Figure 4-147    Dynamic Nozzle Test samples
❒  In the left sample shown above, there are no gaps. 
❒  In the right sample shown above, there are only two gaps, which is 

acceptable. 
Many gaps in the sample indicates that many nozzles in the print head are not 
functioning. This might indicate the need to replace the defective head. In this 
case, consult with your Stratasys service provider.

Samples printed from certain Model materials in this test might not be 
completely cured. Because some of the material remains in liquid (or semi-
liquid) state, you cannot check for gaps in these samples. Do not be 
concerned that liquid resin remains on and around these samples.
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Built-in Tests

The printer application contains a suite of tests for regularly checking the 
hardware and software, and for troubleshooting. 

Because running the tests affects the operation of the printer, you can only open 
the Built-in Tests interface when the system is not printing.

The test suite features:

• The organization of printing-related tasks in categories:
❒  Communications 
❒  Data cards 
❒  Temperatures 
❒  Voltages 
❒  Encoder repeatability 
❒  Print-head heating
❒  Print-head filling 

• A clear display of test results and the source of any failures, enabling you to 
determine if printing is possible or worthwhile. 

• The ability to monitor test results for specific components.

• Troubleshooting tips.
Running these tests can help identify problems in the printer hardware and 
software. A large number of hardware defects (or near-defects) warns you of 
possible printing problems, either for current or future jobs.

Stratasys recommends running the built-in tests in the following cases:
 l as a routine test, once every two weeks
 l as a system check, before major (long) jobs
 l as needed, for troubleshooting
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To open the Built-in Tests screen, do one of the following: 
• From the Options menu, select Built-In Tests.
• Press Ctrl+Alt+B.

Figure 4-148    Selecting Built-In Tests from the Options menu

 
The Built In Tests screen lists pre-configured tests, grouped by component 
categories. In this screen, you select and run tests, and the results are displayed.

Figure 4-149    Built In Tests screen    
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Test List

Test Name
This column lists all of the tests, together with selection check boxes. 

Click the check boxes to select the tests you want to run. To remove a selection, 
click the check box again. To quickly select all of the tests in a component 
category, use the Group drop-down list at the bottom of the screen.

Group
This column shows the component categories for each test. 

This tells you which tests are run when selecting a category from the Group drop-
down list at the bottom of the screen.

Status
This column shows the results of each test after you run it:

Test successfully completed.

Test failed. (Double-click on a failed test’s line to review the failure details.)

Unknown results. (The test has not been run yet.)

Test Selection Area    
In the Test Selection area, at the bottom of the screen, you can quickly select or 
de-select tests by their characteristics:

All        Click to select all of the tests in the list.

None        Click to de-select all of the tests in the list.

Unknown        Click to select all test that have not been run yet (Status = ?).

Group        Use this menu to select tests by component category.

Selection Set        Use this menu to select a pre-configured set of tests to run at 
specified times (computer startup, before printing, etc.).

Running Built-in Tests

To run the selected tests:

➢  Click .

After you run a test, the Save and View command buttons are added to the 
Built In Tests screen.
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Test Results

To save and view a report of all tests:
➢  Use the Save and View command buttons.

Command Buttons

Click the command buttons, on the right side of the screen to perform the 
following operations:

Run
Click to run the selected tests.

Reset
Click to clear previously run tests. This returns the status of each test to Unknown 
(?).

Save
Click to save a report that summarizes the tests run. The report is saved as an 
HTML file. You can save any number of reports for the tests you run; the name of 
the file saved is BITReport [date][time].htm. By default, these files are saved in 
the printer installation folder, but you can save it in any other folder.

View
Click to display the latest test report that you saved. (You can view other test 
reports by opening the relevant files in your Web browser. To do so, open 
Windows Explorer, and double click the BITReport file.)
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Close
Click to close the Built-in Tests screen.

Summary

On the right side of the screen, a symbol represents the combined results of all 
the tests run, using the symbols from the Status column.

All tests successfully completed.

At least one test failed.

Not all tests performed.

Test Descriptions and Troubleshooting

The following table lists the name of each test in the Built-in Tests suite, together 
with its description and a possible reason for its failure. If you need assistance, 
contact your Stratasys service provider.

Test Name Description Possible Reason for Failure
FIFO Non-Interrupt/

FIFO Interrupt

• Tests the data queue in the
DATA PCI card.

• Tests the Windows interrupt.

• If both FIFO tests fail:
Faulty DATA_PCI card.

• If only the FIFO Interrupt test fails:
Faulty Windows interrupt.

System Info Compares the following parameter 
values with the minimum 
requirements.
• physical memory
• available memory
• free space on disk
• monitor resolution

Failure of RAM memory allocation in 
the printer computer.

Parameter Sanity 
Check

Compares the values of all printer 
parameters (in cfg files) to the 
required values.

One or more of the printer parameters 
is not within the required range. 
Details appear in the BIT report.

RFID Verifies the presence of RFID tags 
on material containers, and tests 
them (by writing data to the tag and 
then reading it).

• Faulty RFID reader.
• Faulty RFID reader power supply.
• Faulty or misaligned RFID tag.
• High level of electromagnetic noise

around the RFID tag.

Sub-System 
Communications

Tests communication between 
printer components.

• Disconnected communications
cable.

• Faulty cable.
Cabin Temperature Tests the temperature level in the 

build-tray area.
• Faulty temperature sensor (OHDB).
• Failure of exhaust fan.
• Clogged exhaust filter.

Head Voltages Checks the control of voltages 
supplied to the print heads.

Faulty print-head driver card(s).
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Test Name Description Possible Reason for Failure
Head/Block Heaters Tests the heaters in the print heads 

and in the print-block body.
Faulty heaters or thermistors.

System Voltages Checks if the following voltages are 
within 5% of the required voltage:
• 40V to the print heads by the VPP 

power supply
• 12V to the height thermistors by 

the VDD power supply

• VPP power supply: 
Faulty head driver.

• VDD power supply: 
Faulty height thermistor.

UV Lamps Tests each UV lamp. • Faulty UV lamp.
• Faulty UV power supply.
• Disconnected UV cable.

Axes Limits Tests the hardware and software 
limits of all axes.

Faulty hardware sensors. 
Wrong Max Position parameter.

Block Filling Analyzes the thermistor readings 
when the block is full and when it is 
empty.

Faulty thermistor.

Encoder Steps Count Tests the encoder's reliability by 
comparing readings from multiple 
runs along the X-axis.

Misaligned or faulty encoder.

Vacuum Test Tests the vacuum level in the print 
block.

• Faulty vacuum sensor. 
• Vacuum leakage. 
• Wrong parameters.

Interlock Tests the interlock in the printer 
cover.

• Failure of interlock mechanism.
• Faulty latch. 
• Disconnected cable.
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Replacing Waste Containers

Printer waste contains partially cured polymeric material, collected during normal 
operation and maintenance of the printer. For safety and environmental reasons, 
this material is kept in two leak-proof containers.

Each container has a capacity of 18 kilograms of waste material. The printer 
application displays a warning message when one waste container is full and 
there are 17 kilograms of material in the other container. (If only one waste 
container is installed, the message appears when there are 17 kilograms of 
material in it.) The printer stops printing when the net weight in the second (or 
only) container reaches 17.5 kilograms. When the net weight in this container is 
above 17 kilograms, the software does not allow you to start a print job (or a 
printing activity). You can monitor the weight of the waste containers in the 
printer interface.

Caution
Dispose of full waste containers in accordance with environmental and safety 
requirements.

Empty Model-material and Support-material containers can be used as 
printer-waste containers.

Cleaning the Exterior Panels

The painted exterior plastic panels of the printer has a durable finish, offering 
excellent chemical resistance to common cleaning materials. Follow the 
recommendations below when cleaning these areas of the printer. 

Acceptable Cleaning Agents
• mild soap solution 
• common household cleaners and window cleaners
• common commercial and industrial detergents, 5% solution in water 
• alcohol (ethanol, isopropanol), 10% to 40% solution in water

Wipe the exterior of the printer, using a soft cloth moistened with the cleaning 
solution.

Unacceptable Materials
• industrial solvents 
• cleaning agents containing hydrocarbons, ketones, esters and lacquer 

thinners
• spray disinfectants

• abrasives and agents which could wear away the panel finish

Cleaning the UV Screen

The transparent sections of the printer doors and the service windows (on the 
side of the printer) are made of strong, acrylic material that screen out harmful 
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UV radiation. Use extreme care when cleaning them to prevent the appearance 
of scratch marks.

Caution
Do not use abrasive cleaners or cleaning fluids containing ammonia, alcohol, 
acetone, benzine, carbon or tetrachloride. These materials can cause 
permanent damage to the surface.

To clean the UV screen:

1. Blow off surface dust.
Do not wipe the surface to remove dust; this might scratch the surface.

2. Prepare a 1-percent solution of mild dish-washing soap in water—about two 
teaspoons (10 ml) in a liter of water.
Note:   While soapy water is effective for cleaning, commercial products are also 
available for cleaning acrylic surfaces (for example, Novus® and Brillianize®).
These products give the surface antistatic, smudge and scratch-resistant properties.

3. Soak a micro-fiber cloth in the solution.
Do not use paper towels, which can cause scratch marks.

4. Thoroughly wet the surface with the cloth. Do not wipe! 

5. Rinse the cloth with clean water. 

6. Absorb the solution from the acrylic surface with the cloth, without applying 
pressure.

7. If necessary, repeat to remove any remaining marks, or apply clean water to 
rinse the surface.

8. If the surface is still wet, you can dry it with a clean, micro-fiber cloth by gently 
wiping in one direction.

If convenient, you can apply the cleaning solution and water to the acrylic 
surfaces with a spray bottle instead of with the cloth.
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Removing Models After Printing

After printing models, you should allow them to cool as much as possible before 
handling them. If additional models do not have to be produced on the printer, it is 
best to let the printed models cool in the printer, with the cover closed, as long as 
possible. 

Removing the Build Tray From the Printer

The build tray for the Stratasys J4100 printer is removable, which aids in the 
handling of printed models. You use a special cart to remove the build tray and 
transfer it to the cleaning station.

To remove the build tray:

1. Press F10.
or—
From the Options menu, select Go to Tray Lower Position.
The print block moves forward and the build tray lowers.

2. Raise the cart’s platform and position the docking guides as shown.

Figure 5-1    Positioning the cart for tray removal

Note: Make sure that the anchor on the platform is raised above the docking 
pin on the printer.         
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3. Lower the cart platform so that the anchor fits over the docking pin.             

Figure 5-2    Securing the cart to the printer

4. Pull the build tray onto the cart.         

5. Raise the cart’s platform to release it from the docking pin.         
You can now move the cart to the cleaning area.         

Removing the Support Material

After printed models have cooled, the Support material must be removed. This 
can be done by different methods, depending on the size of the model, how 
delicate it is, the amount and location of the Support material, and other factors. 
The methods described in this section refer to removing general-purpose 
Support materials from models, for most printing applications. Use this 
information as a guide, and adapt the methods (or a combination of them) for 
cleaning your models.

For special printing applications, refer to documents on     the Stratasys Support 
Center  or consult a Stratasys 3D printing expert.

SUP705 (FullCure705) Support material can be removed from printed models 
using the following methods, in this order:

1. by hand

2. water pressure (in a suitable cleaning unit)

3. 1% caustic soda solution (recommended for a smooth finish)

Removing Support by Hand

While wearing protective gloves, break away excess Support material on the 
outside of the model. For delicate models, use a toothpick, pin or small brush 
after dipping the model in water.

https://support.stratasys.com/Knowledge
https://support.stratasys.com/Knowledge
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Removing Support with Water Pressure

For most models, the most efficient way to remove Support material is by using a 
high-pressure water jet.  Consult Stratasys Customer Support for advice on 
purchasing and using suitable cleaning units for your printer and requirements.

Use caution when cleaning delicate models with high-pressure water 
systems.

Removing SUP705 with Caustic Soda

Soak models in a 1-percent solution of caustic soda (sodium hydroxide) to 
remove Support material from difficult-to-reach areas and to give the model a 
smooth, clean finish. The amount of time you soak the model in the solution 
depends on how delicate it is and how much Support material needs to be 
removed, but it is typically between half-an-hour and several hours. In any case, 
you should remove as much Support material as possible before the caustic soda 
treatment, and rinse the model thoroughly (with a water jet) afterwards. 

Warning
Caustic soda may cause chemical burns, scarring and blindness. Mixing it 
with water generates heat that could ignite other materials. Never pour water 
into caustic soda. When diluting the solution, always add caustic soda to 
water. Take adequate safety precautions; always use nitrile gloves when 
handling caustic soda and models soaked in it.

Caution
Caustic soda causes corrosion of the build tray. 
Remove models from the build tray before treating them with caustic soda. Do 
not immerse the build tray in the caustic soda solution.
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Post-Printing Treatment

Post-printing treatment is recommended for models printed with several special-
purpose materials or for special applications. Recommendations for treating and 
finishing models after printing are described in the Best Practices for the desired 
printing material available on the Stratasys Support Center.

Photobleaching for Transparent Models 

Models printed with clear materials, such as VeroClear (RGD810) and VeroUltra 
Clear (RGD820) have a slight yellow tint when removed from the printer. This is 
especially true for models printed with a glossy finish. The yellow tint fades 
naturally over time, but you can greatly accelerate this process by using a 
suitable photobleaching treatment. This involves exposing models to intense light 
immediately after printing.

Photobleaching methods and instructions are described in the Best Practices 
for the relevant clear material. These are available on the Transparent 
materials page on the Stratasys Support Center. 

Refer to the Best Practices for: 
l VeroClear RGD810

Storing Models

Models are cured as they are printed, making them safe and stable for a long 
time. However, proper storage conditions are necessary to prevent deforming.

• Keep printed models at room temperature and in a low-humidity environment.

• Do not expose models to direct sunlight and other heat sources.

https://support.stratasys.com/Knowledge
https://support.stratasys.com/materials/polyjet-materials/transparent
https://support.stratasys.com/materials/polyjet-materials/transparent
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